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What To Do When
Your Internet
Connection Disappears
by Gregory Anderson
ne minute you’re cruising around the Internet.
YouTube, Wonkette, eBay—every-thing’s
flying along. Then you step out of the room for
a while, maybe even overnight, and by the time you
come back the connection is dead. The browser
presents a pitifully empty error page for every site
you try to visit. No email is coming in, and that little
connection icon in Vista’s Notification Area is in alert
mode. We can help.
Network routers and most broadband modems
have admin consoles you can use to troubleshoot
connection status and settings.

O

First, make sure the problem is what you think it
is. Plenty of things can go wrong with Internetenabled programs and their online materials, and not
all involve an Internet connection directly. Try
restarting the program in question to make sure the
problem isn’t isolated to one application. The aforementioned connection icon in Windows can be a good
clue that something is wrong systemwide. Testing
several different kinds of applications (not just
different Web sites) is also a good step. If your
browser, your email client, and your online music
service are all unable to connect, you can be certain
that the issue is bigger than any single application.
Ruling out security software, Windows itself, and
your own hardware can be a little trickier, however.
Check your antivirus, firewall, and any other monitoring utilities to make sure they aren’t blocking your
connection. If you have other machines on your
network, now would be a good time to check them, as
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well. Now look at the lights on your router and
modem. Are they blinking (or not blinking) in their
normal ways, with both WAN (wide-area network)
and LAN (local-area network) indicators functioning
normally? You may need to consult the manufacturer’s documentation to figure out the blink codes,
but they may be telling you something very important. If the modem appears to be normal but the
router doesn’t, your problem may be with your LAN
rather than your connection to the Internet.
Next, you should commit this phrase to memory:
When in doubt, reboot. Once you’re confident you are
dealing with a connectivity issue, the first best step
(as in nearly every situation) is to restart the components in question. Start with your PC. Shut it down.
Then power down your network router. It may have
a power switch on the back, or you may need to
simply pull the plug. Keep the router off and reboot
the modem. To reboot the modem, first reset, turn off,
or unplug the modem. Keep it off for 10 seconds and
then turn it back on. Let it power up and see if it
connects successfully to your ISP (Internet service
provider). Your ISP’s documentation can help you
discern meaning from the flashing lights, but a solid
green from the WAN indicator is usually a good sign.
Then bring up the router. Let it connect to the modem. Finally, power on your PC. Rebooting may not
always solve the problem, but it eliminates most
temporary glitches and removes another easily solved
possibility.
Use the reset button or power switch to restart
your broadband modem and router during the trouble-shooting process.
Take a few moments to look for obvious physical
problems. Start with your connection. Check each
cable, beginning with the network cable running from
the back of your PC to the router. Check the cables
between the router and DSL (Digital Subscriber Line)
or cable modem. Then check your phone or cable
lines. Make sure each sits firmly in its port and that
there aren’t obvious cuts or frays. It may sound silly,
but take 10 seconds to make sure everything’s powered on. You never know when a curious cat or
mischievous toddler knocked something loose. Finally, check to make sure that the other services from
your ISP are working. If you’re a DSL customer and
your phone is working properly, the problem is not
with your phone line. One the other hand, if, for
instance, cable customers see snow on the TV, they
know the issue isn’t limited to just broadband.
Contact your service provider to learn about outages
in your area or problems with your overall account.
2

Now that the easy stuff is out of the way, it’s time
to delve into more serious troubleshooting. First,
connect to your network router’s admin console using
Internet Explorer, if possible. The URL is normally
an IP (Internet Protocol) address. 192.168.0.1 is
common, though you’ll have to check the router’s
documentation for model-specific details. If you can’t
get to the router, the status of your Internet connection is moot. In that case, follow the manufacturer’s
troubleshooting tips or find a way to access Smart
Computing’s Tech Support Center. If you can log in to
the router successfully, check its WAN status and
other settings from the administrative screens.
Again, you’ll have to check the documentation for
both the router and your ISP in order to learn the
precise location of each setting and its proper value,
but often, restoring a corrupted setting or releasing
and reacquiring the connection from the modem will
restore lost connectivity.
If you can’t find a solution in the router or modem’s utilities, contact your ISP’s support hotline.
Make a list of all the steps you’ve taken so far, as well
as all the relevant settings from your router and PC.
Have your account information ready, as well. They’ll
be able to let you know about any broader network
outages that may be affecting your connection as well
as anything specific to your account. Some Internet
outages are account- configuration issues rather than
technical glitches. The help desk can also delve
deeper into modem and network settings than you
can. You may need to exercise patience as they walk
through their scripts, but you’ll get nearer and nearer
a solution as you work with them to work through the
possibilities.

Be Prepared

Losing Internet connectivity can really put a
crimp in normal troubleshooting. It’s hard to find
answers on Google or chat with your ISP’s support
reps when you can’t get online. Take a few minutes
now to gather the following information in one place
so that you have it handy if you can’t get online.
• Users manual for network router or wireless
access point and cable/ DSL modem
• Setup instructions from your Internet Service
Provider
• Any installation discs or software provided by
your ISP or modem manufacturer
• Your machine’s standard IP settings; retrieve
them in Vista by entering cmd in the Start
Search box and then entering ipconfig into
Windows’ command prompt
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•

Telephone contact information for your ISP’s
technical support help desk.
From Smart Computing Tech Support, January 2009 Vol.20 Issue 1, Page(s) 78-79 in print issue.

Media Notes

by Bill Petitt
Southeast Virginia Computer Group
ntel has brought out a new set of CPU’s along
with the accompanying chipset and motherboards. Up until yesterday, that’s the way I had
planned on going with my next new computer. But, as
always happens, AMD has announced a new iteration
of their biggest and baddest CPU, the Phenom II.
Alas, another quandary. I’ll let you know which way
I go.

I

Big Skype Update

Skype will release a big upgrade to its PC client
software early in February, making video conferencing a central feature of the new interface.
The company has also released a beta version of
Skype for Google Android and other Java-enabled
phones, and said a version for Apple’s iPhone is in the
works. Skype also plans to increase its focus on
business customers this year.
Skype 4.0, which has been in beta for several
months, will be released in early February for PC
users, with an equivalent for the Mac OS due later
this year, Scott Durchslag, Skype’s chief operating
officer, told reporters at the Consumer Electronics
Show last month.
The update includes a new codec that can handle
video and audio twice as efficiently as the current
version, according to Durchslag, giving smoother
video and clearer voice calls. Skype 4.0 will support
30-frame- per-second video for people on fast enough
connections, he said.
“The only thing I would caution is don’t forget it’s
on,” he joked, as he demonstrated the software with
a video call from Europe. “Luckily I’m at this press
conference and not in my shower this morning.”
The client displays video in full-screen mode and
the interface has a large green button that makes
video calling more prominent. It also supports picture-in-picture, so the caller can see himself and the
person he is calling.
A video call between three or more people presents
“unique challenges” over Skype’s peer-to- peer infrastructure, however, but it is high on Skype’s priority
list, Durchslag said. “Hopefully we’ll have it in the
not-too-distant future,” he said.
Video is popular among Skype’s 370 million users.
On Christmas Day, 41 percent of all Skype calls were

video calls as people used it to connect with relatives
and friends, he said.
Skype is also coming to more devices. Skype Lite,
the Java-based client for phones, should be available
free from the Google Android store in the coming
days. Along with T-Mobile’s G1 Android phone, it will
run on more than 100 Java-enabled phones from
Motorola, LG, Samsung, Nokia and Sony Ericcson,
Skype said.
The company has developed a Skype client for the
iPhone but needs to reduce its power consumption
before it can release it, Durchslag said.
More businesses are looking at Skype as a way to
cut communications costs, but Durchslag acknowledged that the software still lacks features that
businesses require, as well as a services infrastructure to support businesses.
It will enlist value-added resellers and systems
integrators this year to provide those services. It will
also add better security and management capabilities, and the ability to record digital video, which
some call centers require.
He didn’t give specifics about the planned business
features but said Skype is likely to start by targeting
small and mid-sized businesses.
Ok, I’ve found something for all you guys with
more money to spend than you can find things to buy:
Sponsored Resource: Ten quick fixes for the worst
security nightmares
Sponsored Resource:Learn more about ultra light
notebooks from Asus and the best warranty in the
industry.

AT&T To Launch In-Car
Satellite TV Service

AT&T has revealed plans for its own robust,
satellite-based in-car TV service. AT&T Cruisecast,
slated to launch this spring, promises 22 channels of
satellite TV at launch and 20 more of satellite radio-but will cost serious money: $1299 for the system,
and $28 a month for the satellite TV service (developed in conjunction with satellite industry veteran
RaySat).
A final channel
lineup is still being
d e v e lo p e d , b u t
AT&T says it will
include lots of
family-friendly entertainment, including Disney
Channel, Disney
XD, Discovery
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Kids, Animal Planet, Nickelodeon, Cartoon Network
Mobile, USA, Comedy Central, MSNBC, CNN Mobile
Live and CNBC.
The system requires installation of a 3-pound,
11.3-by-10.3-by-4.3-inch antenna on the roof of your
vehicle. AT&T describes this as “not particularly
noticeable,” but I’d take that observation with a grain
of salt: Check out the rooftop image, above.
AT&T says its technology addresses shortcomings
of other in-car entertainment systems. For example,
the company says, its breakthrough buffering technology keeps the show going even when you’re under
a tunnel or other line-of-site obstacle.
Avis and Budget car rental services have announced plans to make the Cruisecast service available in rental cars at some locations for $9 a day or
$63 a week

TiVo’s Cool New Video Search

TiVo users now have a new way to find video
content right from their couch. The DVR service in
January, rolled out the beta of TiVo Search, a new
system that helps you find content you’re interested
in from many different sources and to search in
interesting new ways.
Owners of TiVo HD, HD XL and Series 3 settop
boxes will find TiVo Search under the “Music, Photos
& Showcases” menu item. With the new system, you
search for a TV show, for instance, by typing in its
name. Once you’ve found the series you’re looking for,
it’s easy to find all sorts of related information. TiVo
Search, for instance, gives season and episode numbers for each upcoming show, so you can find that one
elusive Seinfeld episode you missed.
It will also let you know not only about upcoming
showings from your cable or satellite provider, but
also alert you to opportunities to buy or rent the video
from services like Amazon On Demand. It also finds
related videos from sources like YouTube.
TiVo Search also suggests similar shows – it’s top
suggestion for a series similar to “Arrested Development” was “30 Rock,” not a bad recommendation. And
you can click to see the cast of the show you’re interested in, then find other movies and tv shows they’re
in.
My one gripe about the demo I tried: The system
was extremely slow. TiVo officials say it’s a beta and
they’re working on figuring out how to scale the
system so it won’t crawl.

Windows 7 Beta Goes Public

Many of the reviews repeat the same information:
Aero Glass is glassier than ever, performance tends

4

to be faster than Vista (or at least faster than Vista
was pre-SP1), and gosh, those taskbar icons are BIG.
There has been much rejoicing over the elimination of the sidebar. Although it was a feature that I
liked, I’m just as happy with the free floating gadgets
in Windows 7—and I can line them up on the right
side of the screen just like the Vista sidebar did.
There’s one default gadget included in Win7 that
didn’t come with Vista, and which I really like: the
Media Center gadget that gives you one-click access
to your recorded TV and other Media Center content.
All the rest of the included gadgets are holdovers
from Vista. Now that the sidebar is gone, you access
the Gadget Gallery by right clicking the desktop.
Speaking of the sidebar being “gone,” you’ll still
see sidebar.exe in the Task Manager’s Processes tab
if you’re running any gadgets on the desktop. Apparently they all run in the same process, as they did
when the actual bar was there in Vista. If you close
one or more of the gadgets, the amount of memory
used by sidebar.exe decreases.
Something else that’s gone, but not really, is the
much maligned User Account Control (UAC) security
feature. It’s still there, but it’s much more polite and
less in-your-face than its Vista counterpart. I’ve only
run across UAC a few times in Win7, even in setting
up the OS initially. The best part is that now you can
adjust UAC settings to your preference. You’ll find
this option in the new Action Center in Control
(which replaces Vista’s Security Center and also
incorporates maintenance tasks like Windows Update
and Windows Backup). The slider on the UAC configuration screen gives you four options: Always Notify,
Notify Only When Programs Try to Make Changes
(the default), Notify Only When Programs Try to
Make Changes and Don’t Dim the Desktop, or Never
Notify. The ability to adjust these settings will make
many, many people happy.
While you’re rooting around in the Control Panel,
you might think at first glance that the option for the
Classic Control Panel view has been removed. Luckily, you can still get to it by clicking “All Control
Panel Items” at the end of the list of Categories. One
interesting new Control Panel applet is Biometric
Devices. Here you can allow logon via a fingerprint
device. Then there’s a Clear Type Text Tuner that
works like those awful eye exams in the optometrist’s
office, where they ask you “Which looks better, this
one or that one?”
Credential Manager provides a “vault” for storing
usernames and passwords for servers, web sites and
programs. Windows CardSpace, which you probably
never used in Vista, is there for you to not use in
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Windows 7. The Control Panel also contains a new
applet for Windows SideShow, which makes me hope
that perhaps more devices will be SideShow enabled.
SideShow is a great feature supported by Vista, but
few vendor make hardware that takes advantage of
it.
You’ll notice that the beta is light on built-in
applications when compared to Vista.
There’s no email program, no contacts or calendar,
no Windows Messenger. DVD Maker, Fax and Scan
and Media Player are there, and of course, so is
Internet Explorer (version 8). You’ll still find most of
the same apps in the Accessories folder, including the
excellent snipping tool that was introduced with
Vista, and there’s also a new Sticky Notes application.
Some of the old, familiar apps have gotten updates
that make them more usable. For instance, WordPad
has a new ribbon style interface that makes it look
more like Word, with icons for changing the line
spacing, increasing and decreasing paragraph indent,
formatting text as a subscript or superscript, inserting pictures, inserting drawings from Paint and more.
And speaking of Paint, it got the ribbon treatment,
too. It’s now easier to crop, resize and rotate, insert
shapes, select line width and brushes, and change the
view.
I’d have to say that my favorite part of the new OS
is the improvement in the area of file organization
and search. My first look at Windows Explorer had
me hopping mad. “What have they done with my file
system hierarchy?” I wanted to know. The familiar
file tree that’s been in the left pane since, well,
forever, was nowhere to be seen. Instead all I saw
were a bunch of “libraries.” But as I began to work
with those libraries and to understand just how
powerful this feature is, I stopped missing the file
tree. In fact, now when I go back to Vista Explorer, it
feels hopelessly cluttered with that (mostly) unnecessary hierarchy. Never fear, though, it’s not as if you
can’t access the hierarchy if you really want to; that’s
just a click or two away.

How-to: Burn your Windows 7
.ISO to DVD disc

You will probably get your copy of Windows 7 in
the form of an ISO file. As you know, you will have do
some sort of conversion to be able to install it on a
computer. Here’s the way to do it.

#2 - Download and install ImgBurn
Rather that try muddling through with burning
the .ISO file with whatever tools you might already
have installed, download ImgBurn and use that. That
way we’re all on the same page!
#3 - Burn the .ISO file to DVD
OK, pop a blank DVD into your DVD writer drive
(for now I’m assuming that you actually have a DVD
writer, if you don’t I’ll show you something else you
can do in a moment). With that done, fire up
ImgBurn. Select Write image file to disc.
Point the Source to the .ISO file you downloaded
and then click on the big button at the bottom-left of
the window to kick off the disc writing process.
And then after a short wait, you’re done!
Now you’ve successfully burned the .ISO file to the
DVD … congratulations!
#4 - Use the DVD
You can now use the DVD like any other OS
install disc … pop it in the DVD drive of the system
you want to install Windows 7 onto and boot up the
PC and you should get that Press any key to boot
from CD or DVD message. Press any key to kick off
the proceedings!
What if you haven’t got a DVD burner or just don’t
want to hand over an entire machine to Windows 7
beta testing? Are you stuck? Nope! You have two
options:

Option #1 - Dual boot

Lifehacker <http://lifehacker.com/5126781/howto-dual-boot-windows-7-with-xp-or-vista> has a good
post on how to do this.

Option #2 - Go virtual!

Why give over an entire PC to a single OS when
most are powerful enough to run two OSes
side-by-side. To do this download and install
Microsoft’s free Virtual PC 2007. Once you’ve installed it run the application and it will guide you
through creating a new virtual machine.
Most of the default settings will work for you but
when asked for the operating system, pick Windows
Vista, and when asked about virtual hard disk
options, create a new virtual hard disk. Then, from
the Virtual PC Console select the virtual machine you
created and click on Start.
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As soon as the virtual machine fires up, click on
CD from the menu and choose Capture ISO Image …
and select the Windows 7 .ISO and click Open .
Now click on Action and then Reset to kick off the
Windows 7 install process.

Vista Annoyances fixed in Windows 7

#1 Preview Pane in Windows Explorer – Vista, it
takes at least three mouse clicks, plus a selection
from a cascading menu, to show the Preview pane,
and you have to repeat the process to hide it again.
With Windows 7 you can preview a file with one
quick click.
#2 Overcomplicated Shut Down – Vista’s Shutdown
menu has been roundly criticized for its cryptic icons
and unintuitive options. In Windows 7, it’s been
simplified dramatically to an easy-to-read, easy-tocustomize text menu.
#3 Arranging Windows, Awkwardly – Ever try to
arrange two windows side by side in Windows Vista
(or XP, or Windows 98, for that matter)? Windows 7
makes it dead simple with some genuinely innovative
new window management gestures.
#4 Unpleasant User Account Control – UAC is the
Vista feature everyone loves to hate. Security always
involves trade-offs with convenience, but with Windows 7, there’s a lot less to dislike about UAC.
#5 Ultra-minimalist Defragmentation Utility – The
colorful, almost mesmerizing progress display from
the XP-and-earlier Defrag utility is gone and never
coming back. But Windows 7 does restore some muchneeded progress indicators and offer more control
than the stark Vista version.
#6 No options backup –
<http://blogs.zdnet.com/bott/?p=632&page=7> In
Windows Vista, every edition has a file backup
program, but you can’t choose individual files or
folders to back up. Windows 7 restores that option,
courtesy of a “Let me choose” option that indicates a
refreshing change of attitude for Microsoft’s UI
designers.

Will Your Old Lenses
Work on a DSLR?

Buying a new digital SLR soon? I’ve been asked if
lenses from a film camera will work on a digital SLR.
The lenses from your old camera may work on a
new DLSR. But, you’ll need to select your new camera carefully. You should also know that the lenses
may not work quite as you would expect.
First, in order for the lenses to work, the cameras
must use the same mount. That means you’ll probably need to stick with the same brand camera. There
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are exceptions, of course. Nikon lenses will work on
Nikons and Fujifilm cameras. Minolta lenses work on
Sony cameras. And Pentax lenses will work on
Samsung cameras.
Of course, some manufacturers change lens
mounts from time to time. Also, some lens features
like autofocus may not work with some cameras. So,
I recommend you make a list of the lenses you own.
Then, speak with someone at a camera shop. A
professional will be able to guide you to a compatible
camera.
You also need to be aware of the lens crop. Digital
camera sensors are usually smaller than a frame of
35mm film. So, you’ll get a different angle of view.
This can be difficult to figure out for new digital
photographers.
To make things easier, manufacturers list crop
factors. The average crop factor is about 1.5. You
multiply this by the lens’ focal length. A 50mm lens
behaves like a 75mm lens on a camera with a 1.5 crop
factor. Telephoto lenses become more powerful. Wide
angle lenses become weaker.
It is also worth noting that light hits digital
sensors differently than it does film. So, digitalspecific lenses have special coatings. These coatings
reduce ghosting and flaring. Some photographers
dispute the importance of these coatings, though.
Just remember, if your new digital SLR is the
same brand as your old lenses, there is a good possibility that they will work together. You might have to
spring for some sort of adaptor and loose the autofocus capability.
From the February 2009 issue of The Umbrella Online,
The Monthly Journal of the Hampton Roads (VA) Computing Community.

Sandbox Computing

by Brian K. Lewis, Ph.D.
Sarasota Personal Computer Users Group, Inc., FL
spend a lot of my time surfing the web looking for
research material; computer tech sources, genealogy data, vocal music and other information. This
means that I am downloading many web pages,
clicking on many links and generally opening up my
computer to all types of malware. I always have to be
aware that there are many traps on web pages that
are just waiting for the unwary surfer. It used to be
that having an up-to-date virus checker, a working
firewall and parasite scanners, you could adequately
protect your computer. That changed to some degree
when the “drive by” downloads appeared. Now with
the constant appearance of “holes” in the Windows
operating system (XP & Vista) and the various web

I
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browsers, it is less obvious that you can protect your
computer from unwanted visitors. Microsoft recently
(October 22, 2008) released an out-of-cycle patch
(patch 958644) for Windows for what has been
described as a very serious opening that could be
exploited regardless of the browser you are using.
There have also been recent articles on “clickjacking.”
In this situation “buttons” or links are floated behind
the link you think you are clicking. The only option to
prevent this is to disable JavaScript. That creates
more problems as JavaScript is a very important part
of the whole web experience and is used on almost
every page. So when you do know that you can run a
script and when you can’t? Well, the “Sandbox” may
be a way to surf safely and avoid the installation of
malware on your computer without having to disable
JavaScript.
My Sandbox experience is based on using the
sofware application “Sandboxie” (www.sandboxie
.com) with Windows XP and Firefox 3.0. As with
everything related to computing, your results might
be different. Sandboxie is a very small program,
approximately 450 KB. So it is quick to download and
doesn’t require a lot of memory to run.
Next, let’s take a look at what is meant when I
talk about a computer sandbox. The sandbox is a
complete “virtual computer” running in your computer’s memory. This virtual computer is isolated
from the real operating system files and creates any
files it needs for use within the sandbox. When the
sandbox closes, everything in it disappears unless you
chose to keep it. It’s like having a bank vault within
a building where everything can be locked within the
vault and nothing is removed without special permission. The neat thing is that nothing that happens
within the sandbox can have any effect on your
computer. This means that Trojans, rootkits and
other malware have no chance to affect the operation
of your computer outside of the sandbox. If a problem
occurs when you are running in the sandbox, all you
need to do is shut it down, you are returned to your
normal computer operations and the malware is
erased.
When Sandboxie is started it creates a sandboxed
folder which contains a drive folder, user folder, and
Registry “hives.” The “hive” is Microsoft’s term for
collections of related Registry keys stored together.
The parts of the Registry needed for sandboxed
operations are stored in a hive which is then integrated into the Registry. There are also instances of
Windows services stored within the sandboxed folder
that can be accessed by applications running within
the sandbox. These are referred to as “process ob-

jects” and are needed for normal operations. When
the sandbox is running there may be instances of
these objects running both sandboxed and nonsandboxed. Also, you can run an application within
the sandbox at the same you are running it outside
the sandbox. The complete operating system is not
loaded into the sandbox. This reduces the memory
required for the sandbox operations.
Applications running in the sandbox can not
hijack non-sandboxed programs. Therefore they can
not operate outside the sandbox. New files or other
created objects have a path assigned by Sandboxie
which directs them into the sandboxed folders.
Sandboxie prevents any programs running inside the
sandbox from loading drivers directly. It also prevents programs from asking a central system component, known as the Service Control Manager, to load
drivers on their behalf. In this way, drivers, and more
importantly, rootkits, cannot be installed by a
sandboxed program. This is one of the features that
prevents rootkits from being installed outside the
sandbox.
In actual operation, using Sandboxie is very
simple. To make it even simpler, there is a short
tutorial available on the Sandboxie web site. This can
be accessed from within the program the first time
you run it or directly from the Sandboxie home page
by clicking on the “FAQ & Help” link.
After installation it can be set to load whenever
the computer is started. This puts an icon in the
system tray. Clicking on this icon brings up the
Sandboxie Control Center. This window lists all
sandboxed applications and object. When I started it,
the window indicated nothing was sandboxed. So,
using the menu I selected run an application and
then selected Firefox. This changed the list in the
window to show Firefox as well as the two RegHive
files. With Firefox up, I did my usual web surfing.
Along the way I received a message from Sandboxie
that a new version was available that I could download. At this point, I really couldn’t tell that anything
was different from my previous surfing experience
with Firefox. So I went to the Sandboxie page and
downloaded the new version. After finishing I closed
the Sandboxie Control Center. Then I went looking
for the download so I could install it. Well, it didn’t
exist anywhere on the hard drive! I had closed Sandboxie without marking the update to be saved! As a
result the download was deleted, along with all the
other sandboxed files when I closed the Control
Center. So I opened the Control Center, restarted
Firefox and downloaded the update. This time I
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selected it to be saved before I closed the Control
Center. Then I was able to install the update.
I should also point out that now I have an icon on
the desktop which automatically runs Firefox sandboxed. Sandboxie can be set up to isolate your
browser automatically whenever you open it. To do
so, add the name of your browser’s executable file,
such as firefox.exe or iexplore.exe, to the list of
programs Sandboxie always opens in a sandbox. If
you don’t do this, Sandboxie will not set your browser
to open automatically in the sandbox.
As you can tell from these comments, Sandboxie
does not require a reboot to start the sandbox process.
Sandboxie does sandbox access to files, but not to the
complete hard drive. It does sandbox access to registry keys. It also sandboxes access to many other
classes of system components, in order to trick the
sandboxed program into believing that it isn’t being
tricked. So you can open and close Sandboxie repeatedly while you are using your computer without
having to do any rebooting.
If this discussion has interested you and you
would like to take Sandboxie for a test run, the free
version can be downloaded from: www.sandboxie
.com. This application is free for personal use. However, there is a Pro version available for $30. If you
like the program and can afford it, buy the Pro
version. This software is the work of one person,
Ronen Tzur, and this payment is his means of support to continue working and improving this software. After some experience in running Sandboxie, I
can highly recommend it as an excellent method of
protecting your computer from malware.
Dr. Lewis is a former university and medical school
professor of physiology. He has been working with personal computers for over thirty years, developing software
and assembling systems. This article has been obtained
from APCUG with the author’s permission for publication
by APCUG member groups; all other uses require the
permission of the author (bwsail (at) yahoo.com).

A. Click File > Page Setup, and go to the Sheet tab.
In the “Rows to Repeat at Top” field, enter 1:1,
assuming your column headings are in Row 1, and
click OK. This will ensure that Row 1 is at the top of
every printed page.
To keep your headings visible (again, assuming
your headings appear in Row 1), click to select cell A2
(yes, A2, not A1), then click Window > Freeze Panes.
Once selected, you can scroll through your spreadsheet and your column headings will remain within
view at all times.
Q. How can I select the file types that my Windows
Media Player will play?
A. Open Windows Media Player (WMP) by going to
Start > Progarms > Windows Media Player. Click Tools >
Options > File Types tab. Select the check box next to the file
type(s) that you want to open automatically using WMP, such
as .WMA, .WMV, .MP3, MIDI. If you want to use WMP as
your exclusive media player, click the Select All
button to choose all file types. Click OK to save your
changes and exit.
Q. When I visit Web sites using Internet Explorer, a
small screen pops up stating a line error has been
encountered. It asks if I want to debug it. If I click
“No,” the pop-up disappears, but it comes back. If I
click “Yes,” it goes to a debugging page of some type,
but I don't know what to do from there. How can I get
rid of this?
A. If you disable the debugging function, you won’t
encounter those pesky pop-ups in the future. The
debugging function is intended for programmers and
developers, so by disabling it you won’t be adversely
affecting your computing life. To turn it off, click
Tools > Internet Options > Advanced. Scroll down to
the Browsing section and remove the check marks
beside “Disable script debugging (Internet Explorer),”
“Disable script debugging (Other),” and “Display a
notification about every script error.” Finish up by
clicking Apply > OK, close then reopen IE, and you
should be all set.

Wanted: Positive Customer
Service Experiences
Prevent Scrolling Excel Headings

Q. I am building a large Excel address file and I
want to know how I can make the column headings
(Name, Address, Email, etc.) appear on each page.
Right now they only appear on the first page. Also,
isn’t there also some way to keep the column headings visible, so they never scroll off the screen?
Thanks, Mr. M.
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I’m working on an article about the ethereal
concept of customer service. Examples of abysmal
service abound, but if you have had an outstanding
experience with customer service-it need not be
related to computing or tech support-tell me about it.
Be sure to include the name of the company, what
your call (or email) concerned, and what you most
appreciated, or what most impressed you, about the
service you received.

The Rochester Computer Society, Inc. Monitor / March 2009

Published submissions will be edited, so don't be
concerned about grammar, punctuation or spelling. If
your submission is selected and approved for publication, you will receive a copy of the published work.
(What, you were expecting cash?) Please send your
experience(s) to me at MrModem@mrmodem .com.
Thanks very much.

Mr. Modem’s DME (Don’t Miss ‘Em)
Sites of the Month
Little Known Facts Show

This family-friendly site features short stories and
vignettes about Americana. The site includes fun
facts about American presidents, inventions, sillybut-real laws, amusing town names, and trivia fans
without a life can read a new “Little Known Facts”
story every day. These stories are similar to Paul
Harvey’s world-renowned “The Rest of the Story”
feature.
www.littleknownfactsshow.com

Plot-O-Matic

Have you ever sat in a movie theater, robotically
consuming a $27 tub of popcorn and thinking to
yourself, “I can write a better movie than this drivel”?
Judging from what’s passing for entertainment these
days, you probably could. In fact, it’s even easier than
you might think. Using the Plot-O-Matic (patent
pending), select your characters and the plot elements you would like to include in your movie. When
you're satisfied with your choices, click “Lights!
Camera! Action!”
http://tinyurl.com/6n42xd

Unusual Hotels

As its name implies, this is the place to turn if
you’re seeking non-traditional hotels. Perhaps you
have mole-like tendencies and would like to stay
underground, or inside an igloo, in a tree, or even
underwater? If so, you’ll find the opportunity here.
Categories include Art Galleries, Lighthouses, Underground Caves, and even Prisons. Yes, for $150/night
you can stay in a fabulous Turkish Prison. See,
dreams do come true! Hotels are rated on a scale
ranging from “Different” to “Wow,” though I’m surprised there isn’t a “Get-me-out-of-here!” category.
www.unusualhotelsoftheworld.com/
For plain-English answers to your questions by
email, plus great computing tips, subscribe to Mr.
Modem’s award-winning newsletter. Subscribe using
Promo Code 4022 and receive two free mont hs with
your 12-month subscription (60 issues!) To view a
sample issue or subscribe, visit www .MrModem.com.

From the DealsGuy
by Bob (The Cheapskate) Click
Greater Orlando Computer Users Group

Suggested Reading

I’m sure you’ve heard about some of the innovations that United Parcel Service has created in the
interest of saving money, such as calculating their
delivery routes with a minimum of left turns. This
article will inform you of many other ways they are
saving money, some that will surprise you <http://
www.informationweek.com/news/showArticle
.jhtml?articleID=212900815>. Everything you can
think of is under scrutiny. However, the most interesting part is further into the article.

Feedback

I certainly had plenty of feedback from my experience with Best Buy. It seems that many others have
had a bad experience with Best Buy and wrote to tell
me about it. My preference for that type of store was
Circuit City, but that has come to an end. I’m sorry to
bid them farewell because Circuit City always treated
me right.

A Bit About Work

My wife and I have worked some great trade
shows lately. One was the Fun Show, which is also
called the Coin Show. I sure saw many dollars worth
of coins etc. displayed by people from all over the US.
Police continually patrolled the show floor and they
now have police on horseback roamed the parking lot
to prevent any robberies there, which have happened
in the past. In fact, there have even been vendors
who were followed by robbers to a distant town where
they were robbed when they stopped at a motel for
the night. Obviously, the robbery was substantial.
Then came the Surf Show, which happens twice a
year. It’s a large show and draws attendees from the
US states with beaches, and from the Caribbean.
Fashions make up much of the show, but there are
lots of other things to see, not to mention the models
(mmmm).
On the heels of the Surf Show came the “Shot
Show” which occupied 1.1 million square feet of
exhibit area in the West complex of Orange County
Convention Center. <http://www.shotshow.org>. I
saw a shotgun with a price tag of $100,000 and that
booth also had a deal for four assorted shotguns and
rifles for only $400,000. Too bad my Visa limit was
too low for that. Those guns with their GOLD triggers
would have made a nice gift for my wife’s husband.
The show had about 25,000 attendees and security
was tight with all kinds of guns and knives all over
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the place. Most of the attendees I talked to said they
were unable to see the entire show in one day. Others
said they were back again to keep looking because
you always find something you didn’t see the first trip
through. That is so true of trade shows.
I’ll also give you the URL for the IAAPA Attractions Expo <http://www.iaapa.org> which is a show
we worked in November that is all about amusement
park rides and other attractions at carnivals. It’s
always fun to work it and some of the rides are set up
and working right there on the show floor. There is as
much as 65 feet of height in certain areas of that
building if needed. There were many inflatable
attractions this year and lots of food exhibits (Burp).
The Power Gen Show was extremely interesting
with everything from small to very large generating
systems <http://www.power-gen.com /index.html>.
Three vendors offered giant windmill generators, GE,
Mitsubishi and Vesta with impressive movies illustrating the construction. If I had one of those, I could
power the entire neighborhood. You might also be
interested in the Electronic House Expo that will be
in Orlando in March.
<http://www.ehxweb .com/>

OLE fields. It offers numerous features that are not
available, or only partially available, in other repair
engines. Among those features is support for the new
Access 2007 format, batch recovery, command line
support, shell integration, and drag & drop support.
Advanced Access Repair 2.0 can also recover indexes,
auto-number fields and relations, can output repaired
MDB files in different formats, and can search for
MDB database files on the local computer according
to special criteria. Password encrypted Access databases? Recovered; deleted records and tables; no
problem.
Advanced Access Repair 2.0 runs under all versions of Microsoft Windows, including Vista, and
supports all versions of Microsoft Access including
Microsoft Access 2007. A single-user license costs
$299.95 (US). Volume buyers are entitled to discounts. They are offering a 10% discount if you use
the code DNC-SGKO-DG when ordering. The code is
good through March. Further information on the
product, as well as a free trial copy is available from
<http://www.datanumen.com/ aar/>.
Direct download link:
<http://www.datanumen.com/aar/aar.exe>

How About Repairing That File

Keep An Eye On That Network

DataNumen Inc. has released Advanced Access
Repair 2.0. If .MDB files are corrupt or damaged, this
powerful repair engine will recover the data with
precision. The performance of Advanced Access
Repair is improved and supports MS Access 2007 and
Windows Vista. If the .MDB files are corrupt or
damaged in some way, Access can neither open the
files nor recognize any data in them. Advanced Access
Repair uses advanced technologies to scan the corrupt or damaged Microsoft Access databases (.MDB
files) and recover the data in them as much as possible.
Advanced Access Repair 2.0 is based on a comprehensive understanding of the Access MDB database
format. The advanced algorithm of this powerful tool
allows you to recover every possible item in the MDB
database files because the recovery process does not
rely on the structure of the original corrupt or damaged MDB database file. Sometimes the structure is
completely damaged and cannot be recognized, but
Advanced Access Repair is still able to analyze the
raw MDB database file byte by byte and recover most
of the data.
Advanced Access Repair 2.0 can successfully
repair Microsoft Access 95, 97, 2000, XP, 2003 and
2007 databases, recover the structure and records of
the tables in Access databases, or recover MEMO and
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Softinventive Lab, the developer of software for IT
Administrators, introduced Total Network Monitor,
the program which enables IT Administrator to be
continuously informed about every single moment of
their network’s performance. If there is any error or
failure in a network computer’s performance, the
program immediately alerts you by sending a message to your E-mail, Jabber account or Event log.
Total Network Monitor 1.0.1 helps to prevent serious
bottlenecks and the program builds a detailed report
on the type and time of any failure or error that
occurred.
You can check any aspect of each utility, server or
file system, HTTP, FTP, SMTP/POP3, IMAP, Event
Log, Service State, Registry, and many others at any
time. Total Network Monitor allows you to create
monitor lists and customize them as much as possible
according to your needs. It gives you all the tools for
convenient monitoring of your network devices’ state
and has a number of specific probes checking the
remote utilities and server’s state. For your convenience all probes are divided into three main groups;
Internet, Windows and Miscellaneous. The program
enables you to build a demonstrative network map,
which is handy in network control.
Total Network Monitor 1.0.1 runs under Windows
2000/XP/2003 Server platforms including Vista, and
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costs $145/112 euro per license for one installation,
$115/89 euro per license for 2 to 5 installations,
$95/73 euro per license for 6 to 10 installations. They
offer a 20% discount on request. <info@softinventive
.com>
Product page link:
<http://www.softinventive.com/products/totalnetwork-monitor/>
Download link:
<http://www.softinventive.com/downloads
/tnm-setup.exe>

Use This Instead of Print Screen

Here is a suggestion by a reader who preferred not
to be mentioned: When you want to save what’s on
your screen, many use Print Screen to save it to the
clipboard. However, you don’t always get everything
you want, such as the curser, using that method. Why
not try FastStone Capture, which is a freebie. The
following is from their Web site: “FastStone Capture
6.3, Shareware (last update: 2008-10-15): A powerful
lightweight, yet full featured screen capture tool that
allows you to easily capture and annotate anything
on the screen including windows, objects, menus, full
screen, rectangular/freehand regions, and even
scrolling windows web pages. It also allows you to
record screen activities and sound into video files.”
FastStone also offers other software so see
<http://www.faststone .org /index.htm> for a description of their various products.
That’s it for this month. I’ll have some more new
product announcements on my Web site that didn’t
offer discounts. Meet me here again next month if
your editor permits. This column is written to make
user group members aware of special offers or freebies I have found or arranged, and my comments
should not be interpreted to encourage, or discourage,
the purchase of any products, no matter how enthused I might sound. Bob (The Cheapskate) Click
<bobclick at bellsouth dot net>. Visit my Web site at
<http://www.dealsguy.com>.

There Is More to Music
than the iPod®
by Mike Morris
Editor, Front Range PC Users Group, CO
here is more to music—and more to life—than
the iPod. I think I can prove that statement
with the words that follow. Please don’t misunderstand me. I admire the iPod as a successful
product—a success technically and financially—even
though I don’t have one. However....

T

I need to start my “proof” by saying that in previous articles that I have written for this newsletter, I
made a claim to being an Old Analog Guy (as a
reminder, the acronym = OAG and is pronounced
“ogre”). It is with that persona that I bring this
subject to your attention.
I just completed a catalog of nearly 300 old LP’s
that belonged to a family member who died last year.
And when I say old, I mean some of those LP’s have
release dates more than 50 years old. Some of the
recordings are much older than that. There are many
memorable, and even historic, performances recorded
on those albums.
A small part of that music has been re-released on
CDs. But there is much of that music—almost all
Jazz—that you will not currently find in any digital
format. So put down your iPod (or one of its imitators)
and please listen to what I have to say.
I decided to create a database for this catalog
using Microsoft Access®. One significant issue, as you
might expect, is just how much information to include
in the database. This database is for family use—not
for radio station or other broadcast use. I did, however, want to make a record (no pun intended) of
whatever information was necessary to properly
document the collection. The most significant decision
was related to the track (song) names, sequence and
times on each side of each LP. Clearly, if I needed to
document that information, both the data entry task
and complexity of the database were going to be much
higher. If the average number of tracks per side is 4
(it is probably higher), and I wanted to include all
that information, then I was faced with a data entry
task of 4 x 2 x 300 = 2400 entries (plus all the other
information I wanted to include).
“No big deal” you say—there are many much much
larger databases in the world. You are correct. But
remember, I am an OAG (please correctly pronounce
that acronym). Therefore I was looking for an “easy”
way to complete this task. Credit is due to Ken
Campbell of radio station KRFC (more on that in a
moment), a local public radio station, for a solution.
Ken told me about an online music database called
allmusic.com (http://www.allmusic .com) (yes, it is
spelled with all lower case letters). It turns out there
are many online music databases (a Google® search
turned up more than 68,000, using the phrase “online
music database”). The allmusic.com database was the
best for my catalog project for the following reasons:
1. A successful search for an artist will provide an
Overview, a Biography, a Discography (a list of all
albums by the artist known to the database, with
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title, date and label), Songs, Credits, and Charts
and Awards.
2. From the discography, one can click on an album
and get information (usually) on the album tracks
(including times), composer(s), recording date(s),
release date, label, format (LP or CD), the label’s
catalog number, and, for some albums, a review of
the album.
3. The search options include artist/group, album,
song, classical work.
4. There is substantially more information about the
Jazz genre that just a list of names and dates. For
example, on the Jazz “home page,” there are a
number of “Related Essays” on Jazz, including “A
Brief History of Jazz.”
For a project such as the cataloging of an existing
music collection, with LP’s that are up to 50 years
old, this database is the best choice by far of all of the
databases examined or considered. It is the equivalent of an encyclopedia, and the functionality makes
searching easy, with related data presented on a
single page. The ability to link from a list of albums
(discography) to a single album (or CD reissue)
provides very efficient searching for a project of this
type. That is not to say that it is error free. There are
albums not included in the database—the web site
makes no claim that it contains every album ever
released. There are also tracks missing from some
albums (or the track order in the database doesn’t
match the order on the disk). An album may be in the
database, but not in the artist’s discography. And,
there are numerous problems with release and
recording dates. Still, the “pros” far outweigh the
“cons.”
There is a feature offered by this web site that is
unique. Each page (any of the choices listed in item 1
above) has a “Corrections to this entry?” option,
allowing the user to submit corrections. Those corrections are then researched for confirmation (if the web
site statement is correct) before they are added to the
database. That feature was used extensively during
the research for this music cataloging
project—although not every error or missing item
was submitted.
For my project, the search by artist was the most
effective. If an album was not listed in the artist’s
discography, a search by album was the alternate
choice. Although the database has many very early
jazz albums, there were a few albums in the collection, both old and new—or at least “newer”—by wellknown artists that were missing from the allmusic
database. So, although not perfect, the allmusic
database is an excellent research tool, and you don’t
12

need the iTunes media player (or any other media
player) to use it.
The database is not limited to research, however.
You can listen to short sound bytes from some tracks,
and there are links that allow you to buy selected
tracks or albums (correction – CDs).
OK, so your iPod and the iTunes media player are
great for listening to (and buying) current and even
“relatively” old music. But the iTunes media player is
not going to help you—to same extent as the allmusic
database will—find classic old Jazz performances
(and perhaps classic performances from other genres). And, you must have the iTunes media player
installed on your computer before you can do any
searching with it.
You may be wondering why I am talking about
online databases and why I consider a good online
database important to my “proof.” Yes, there is a
relationship. But before I offer the conclusion, I have
several comments on other databases.
Another online database used rarely was Gracenote®, a wholly owned subsidiary of Sony Corporation
of America. Gracenote is used “…for digital media
recognition of CDs, digital music files, and streaming
audio. With the most comprehensive database of
music information in the world, the Gracenote Media
Database contains information for more than 80
million tracks and 6 million CDs....” This database is
normally linked to media players, such as Winamp©,
to automatically identify music on a CD or from a
download. It provides album title (and, in some cases,
an image of the album cover), and track names—if
you connect through a media player (or other audio/video equipment with the enabling software
installed that is connected to the internet).
If you connect to Gracenote directly from a
browser (http://www.gracenote.com/), the search
options are artists, albums, tracks. A successful
search on an artist returns a list of albums (a lot less
than the allmusic database) released by that artist
that are known to the database. It is important to
note that the quantity information in the Gracenote
advertisement makes an explicit reference to CDs.
The album information is similar to that in the
allmusic database, except that there are no track
times. There are, however, links to the lyrics of some
tracks—for those songs that have them. Also the
“Buy” buttons are much more prevalent, and much
more obvious in the Gracenote database, compared to
the allmusic database.
Another online database examined briefly was
Rhapsody®, http://www .rhapsody .com /home .html,
a service provided by Real Networks.com, better
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known for its Real® media player. The company
claims to provide “Technology and services that help
people enjoy digital entertainment whenever and
wherever they want.”
Connect to the Rhapsody website and the first
thing you will notice are the annoying animated ads.
Get beyond that and the search options are artist,
keyword, track, album, composer, video, lyrics, and
playlist. If a search for an album is successful, you
can, for most albums, get track information by
clicking on the album image—but that track information (no times) is very probably going to be from a
more current CD release, not from the original LP,
depending on how old that original LP is and how
popular the album was. However, there is nowhere
near the same level of information available from this
database, compared to the allmusic database. The
Rhapsody database is organized for listening to (or
buying) music that is already known to the user,
either by song name or by artist (in my opinion). It is
not an effective research tool for finding information
on old LP’s.
It is not necessary to have the Real player installed in order to search the Rhapsody database.
Now listen up everyone! Here is my reason for
talking about music databases:
There is some great old music out there! In all
genres. Please don’t get so comfortable with your iPod
that you ignore that music. Especially when you have
a resource such as the allmusic online database to
help you identify it, catalog it, find reviews on it and
find some history of it.
I suspect that many of you reading this article (I
hope there are many readers) have some of that
“great old music” sitting on your shelves or in your
cabinets. Or perhaps stored away somewhere. If so,
“unstore” it. You will, I am certain, enjoy that music,
especially with the added information available from
the allmusic database.
And that is what I mean when I say “There Is
More to Music than the iPod.”
Here is the additional information I promised on
radio station KRFC:
Front Range PC Users Group (FRPCUG) has a
partnership with KRFC, 88.9 FM in Fort Collins, CO.
KRFC provides “Community powered music, news
and entertainment.” For more information, connect to
http://krfcfm.org/. FRPCUG provides computer maintenance help to KRFC, and, in return, KRFC helps
expand the knowledge of FRPCUG activities within
the local community. An internet audio stream is
available from the KRFC web site.
This article has been obtained from APCUG with the

author’s permission for publication by APCUG member
groups; all other uses require the permission of the author
(twriterext (at) gmail.com).

Magic Word Brings Email
to the Offline World

A review by Gabe Goldberg
Computers and Publishing, Inc.
f you've ever wondered how to bring email to the
techno-phobe in your life, the answer isn't
Abracadabra, it's Presto.
If you're reading this online, you own or have
access to a computer. But you likely have friends or
relatives—perhaps elderly, budget-restricted, technophobic—who don't. So they're not in close touch and
can't share online family or community activities.
Presto <http://www.presto.com> is a combination
color inkjet printer and paid Web-based service which
allows people without computers to receive email,
including attachments.
Setting it up is simple: after purchasing the
device, someone with just a bit of tech savvy creates
the account, picks an email address (such as
gabeg99@presto .com), and lists people allowed to
send email to the address. At specified times of day,
the printer dials a toll-free telephone number,
downloads accumulated email, and prints it.
With only two controls—Volume and Stop—it's
easy to operate. It plugs directly into a telephone jack
and doesn't need a separate phone line or jack or even
a splitter, since an existing telephone or accessory
(answering machine or Caller ID device) can plug into
it, daisy-chain style.
Presto is ideal for letting seniors receive email
from children, grandchildren, friends, former
colleagues, military buddies, etc. And it's useful when
businesses request customer email addresses to
conduct or simplify transactions. It handles pictures
and many attachment formats nicely, printing them
as if it was a FAX machine. So it allows sharing any
online or computer content as PDF files such as maps
and directions, travel itineraries, Web pages,
spreadsheets with financial or family contact
information.
Simple steps authorize new people to send email,
and when ink runs low, the printer is smart enough
to either alert the person who set up the account or
automatically order new cartridges.
After failing for a dozen years to excite my in-laws
about email—they steadfastly resisted being
online—my retired Navy father-in-law fell in love
with a Presto I loaned him, discovering that it let him
hear from his old Navy buddies around the world.

I
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And receiving color pictures of the grandchildren
sealed the deal.
The printer costs $150 or less (always comparison
shop online!) and the service costs $12.50/month with
yearly subscription. The only thing missing is the
printer downloading paper and ink through the
phone line—but that would need real magic!
This article first appeared on the Tiplet Web site,
<www.tiplet .com> and is copyrighted by the author,
Gabriel Goldberg. All rights are reserved; it may be
reproduced, downloaded, or disseminated, for single use,
or by nonprofit organizations for educational purposes,
with attribution to Tiplet and the author. It should be
unchanged and this paragraph must be included. Please email the author at tiplet@gabegold.com when you use it, or
for permission to excerpt or condense. Tiplet's free
newsletter provides weekly computer tips.

Significant Bits

by Sean N. Henderson

VP, Marketing & Public Relations,
Danbury Area Computer Society, CT

On Software Installations

I

received as a Christmas gift Ahead's Nero 9—a
CD/DVD burning suite with some authoring and
backup tools as well. I have a combination of
software pieces already on my laptop that in some
way do some or all of what Nero 9 claims it can do.
However, the promise of having all these tasks
integrated into a single package seemed appealing, so
I decided I'd give it try. I had also recently reinstalled
my copy of Nero 6 on my downstairs PC and was
pleasantly reminded how much better I liked Nero 6's
interface, so this was another push to try Nero 9.
The Nero 9 installation took 45 minutes on my
laptop. One colleague mentioned that maybe I should
have tried the install with my antivirus software
turned off to speed up the process. Except for
operating systems, I’m curious why a software
package would take 45 minutes to install in this dayand-age of high-speed processors and drives.
Nero 9 is much more involved than Nero 6 and
similar versions, where Nero 9 includes media
players, some authoring tools, and looks like it will
replace the need for other software items. In my case,
my laptop had separate programs already for viewing
DVDs and authoring DVDs/VCDs.
Remember when installing any software, and
especially anything that's a “suite” to make a restore
point first and backup your system. I'd also
recommend if the install left some installation related
files, to keep those around, since some software titles
need the leftover installation files to uninstall
themselves.
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First impressions of Nero 9 are that it will
extensively “hook” into the Desktop environment,
changing file extension associations, and adding
context-menu options. For myself, I'm more fond of
applications that do not touch the registry and or are
“portable” in nature, so Nero 9 has already a bad
score in my book before I've even done anything with
it yet. While the installer gives options for which
components and templates to install, there is no
expert mode to prevent Nero 9 from messing with the
file extensions. Also, Nero 9 claims some file
extensions that are common or else used by another
application.

Opera Mini and Palm TX Part II

You’ll recall I had mentioned previously about
using Opera Mini on my Palm TX. After a month or
so of usage, I’m finding that it works okay most of the
time, but it is not really optimized for different
networks. In one instance I had to delete all the
scanned entries for other Wi-Fi hotspots so that it
would stop trying to logon to my distant and not
present work network. So currently, I only use Opera
Mini on my TX for home use, and the Blazer
otherwise. Be forewarned, having installed the
particular Java layer and Opera Mini, my Palm TX
has tended to crash more when using Opera Mini or
Blazer.

Editing Just About Anything

Something I find somewhat irritating when trying
to help another computer user with a problem or task
is when the person really has not taken the time to
learn their software or operating system from a
navigational perspective. I can tell they do not know
the software well if they do not use the keyboard
and/or keyboard shortcuts. (These keyboard shortcuts
are also referred to as “hot keys” or “key
combinations”, and so on.) This is where the person
helping, such as myself, says, “Please get out of your
chair and let me drive.” If you use a computer and do
not know your hot keys, read on.
The mouse and graphic desktop are great at giving
people quick access to files and a shorter learning
curve for applications. However, if someone's primary
way to interact with a computer is by way of the
mouse, then they may likely take longer to do a task,
especially spreadsheet work. The reality is that
people are capable of typing (keyboarding?) faster
than they can point-and-click (or speak), menu diving
or clicking around the screen at teeny-tiny hieroglyphs that may-or-may-not be a link.
A quick way to learn all the key combinations for
your desktop and applications is to go cold-turkey and
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simply to take the mouse off of the computer, have a
list of shortcuts and go from there. Here are some hot
keys in Windows XP that are pretty common to help
get you going. (Check your manuals and or on-line for
your particular desktop, application, and operating
system if different.)
Ctl-Esc
Start Menu
Alt+F4
Close window, application, or Windows
itself
F6
Select or highlight whatever is in the
location field, if present (browsers,
directories)
F1
Show help
Ctr-F1
Hide help
F2
Rename a file (Windows and many
applications using the standard open
file dialog)
Ctl-c
Copy selected area into the 'Clipboard'
aka the buffer
Ctl-v
Paste from the Clipboard (buffer)
Ctl-z
Undo last action

Links

Keyboard Shortcuts for XP
http://support.microsoft.com/kb/301583
Excel 2003 Keyboard Shortcuts
http://office.microsoft.com/en-us/excel
/HP052037811033.aspx
Sean N. Henderson is regular contributor to DACS.doc.
More information at http://seannhenderson.net/dacs.html.
This article has been obtained from APCUG with the
author’s permission for publication by APCUG member
groups; all other uses require the permission of the author.

Editor's finds:

University of the People will open its virtual
doors in April 2009. http://uopeople.com/site
/index.asp?depart_id=104898
http://lifehacker.com/5144665/yourfonts-turnsyour-handwriting-into-a-personlized-font [free and
fun]

Society News
Minutes from Feb. Planning Meeting

by Steve Staub, President.
e started the meeting at 7:00 pm. Present
were Bob Avery, Tony Dellelo, Arpad
Kovacs, Mike Lavelle, Sally Springett, and
Steve Staub.

W

The first topic was a review the January general
meeting. We all agreed that we had an excellent
presentation. We then proceeded to make sure
everything is in order for February meeting. We then
discussed our March meeting presentation which is
"Exploring MAC Possibilities." Our presenter is
Sound Bite Steve Rea. Everything looks good. We
talked about this month’s newsletter printing.
Everything should be ready to go by Feb. 14th.
The treasury looks good. Club member Dennis
MacMahon is helping us get the necessary paper in
line because now all not-for-profit groups have to file
a federal tax form 990N.
We briefly touched on our picnic which will be in
August. We have a cabin, so were ahead of the game
this year.
The last item we covered is every year we have to
have election of officers in May. Our by laws state we
need a nominating committee. This committee will
need to fill the following positions with either current
or new officers. The following offices need to be
covered; President, Vice President, Secretary,
Treasurer and one member at large. Please volunteer
for the nominating committee.

Program Meeting

Extended Help's Half Hour

Led by: Arpad Kovacs
Recorded by Jan Rothfuss
Q:
A member has a problem with a Linux
installation.
A: It was suggested that he try the installation from
the package manager
Q: Does anyone have any experience with MagicJack
– telephone?
A: This is a legitimate software but no other member
is using it. Vonage is still the best and includes
technical support. Arpad prefers Skype – 2 cents per
minute. An issue is that there is no return phone
number capability. Skype can route calls to your cell
phone, too. You set up an account with them and
purchase minutes using PayPal or using calling cards
that can be purchased at Walmart.
Q:
One member bought a new router. After
installation, he wanted to add security. The router is
a PEW631BRP – Trend Network. He used Road
Runner.
A: 192.168.0.100 may be the IP address to connect.
He might have to open up a command window and
use ipconfig to establish.
Q: On XP in IE 7, he was able to see recent sites
visited. Can he do this in Vista?
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A: You may need to click on the Vista favorites tool
bar. Mozilla Firefox has a similar feature. Our
current club secretary will check things out while at
work and report back if she discovers anything.
Q: Vista 64 bit does not allow the use of a sandbox –
an area that holds vermin and will be cleared out as
you close down IE.
A: It is available for free as a plugin. But will not
work with XP SP3 either.
Q: How can you tell whether you are running in 64
bits?
A: You need to check your system specs.
Q: When using RoadRunner email account, he gets
a series of 1kb files, maybe 100 per day. Is it possible
to block these out?
A: This is a spam. Do not click on them. Usually the
mail has been scrubbed before it gets to you, hence
the size. A message of "Virus has been removed" will
appear. Frontier does a similar thing.
Q: A general question to all: What is everyone’s
major computer gripe? Answers will be solicited after
the break.
Q: There was a question about a side bar that runs
under Vista.
A: Arpad demonstrated the use of a sidebar that he
has created using applets that monitor CPU. There is
a Visa sidebar applet that allows you to add more
gadgets as already installed on your computer. You
can add more gadgets online, too as found under the
Microsoft site. You can add news headlines, eBay,
stock quotes, email recent arrivals. Arpos admits that
this is one feature from Vista that he likes.
Q: A member had an HP computer. It started with 60
gig and now has tried 160. It is now formatted for 127
gigs. After 6 months of use, it now is giving him
trouble. Are some of the files getting lost in this 30+
gig unused space?
A: The unused segment is not formatted so files
cannot be placed there. You should be able to
partition the drive into segments so that all available
capacity can be used. But you do need to partition it
using a machine that can accept the full size.
Q: What is your major gripe with computers?
A: Start-up Time. There is a function called "Express
Gate" that assists the process using a hidden
partition. This promises 6 second from startup to an
open browser. A file is added to your root directory.
Netbooks laptops have startup times of 10 seconds.
$199 at Best Buy. There may also be a program that
causes a delay against your startup files. Those that
are extras are delayed. You can also use the basic
StartUp Manager to remove programs that you do
not want to have come up automatically. You would
16

then launch them manually. StartUP CPL is a
program that will install a control panel that will go
directly to the startup programs.
Q: How can you tell which programs you need?
A: Under www.blackviper.com.winXP/servicecfg .htm
is a service to chose the best items, allowing you to
scale down those that are not needed.
Q: A member has been trying to copy audio records
into files. He is running XP. He has tried using
Audacity. When he tries, his system crashes.
A: Try downloading the alternate file—table or beta
version. You may be able to contact the speaker who
came to our meeting in January. He did say that
‘noise’ can be an issue. Call SoundBytes on a Sunday
morning.
Q: Thunderbird mail is giving him trouble. There
were messages in the queue one night but they
disappeared when he went back the next morning.
A: Perhaps they were moved to an archive. You may
need to check your other computers. The mystery
remained unsolved.
Q: If you have an application and the original disk,
how much risk is there if you reinstall?
A: A repair will usually replace all the files, placing
the software back to its original image. You will want
to save any personalized contents before starting the
repair or reinstall.
Q: One member has an old Photoshop where the
original CD no longer is usable. Can it be recovered
from his hard drive so that he can keep a copy if
needed?
A: PhotoShop 5.0 can be copies and pasted to a CD or
flash drive.
Q: Steve has an HP printer that he replaced. He
added the new driver and it did not work. Tony
rescued him by finding a hidden driver. This was
causing a conflict. Once found, all is well. Is this a
common problem?
A: One other member indicated that he had a similar
problem. He needed to take everything out and
reinstall.
Q: Tony would like to virtualize an instance of Linux
on his Windows machine.
A: Microsoft Virtualpc is a free tool that can be used.
Version 2007 SP1 will work on most windows pcs.
VirtualBox will work if starting with Linux and
creating a virtual windows instance.
Q: Arpad demonstrated the creation of the virtual
machine. He also then loaded DSL—arn Small Linux
from a flash drive that one of the members had with
him. Shazam!
Q: Arpad also has some MacIntosh emulators. He
demonstrated two of them, showing that they came
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up as if running a Mac either version 5 or version 9.
A third one emulates a G4.
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Monitor or monitor may refer to: Monitor, Alberta. Monitor, Indiana, town in the United States. Monitor, Kentucky. Monitor, Oregon,
unincorporated community in the United States. Monitor, Washington. Monitor, Logan County, West Virginia. Monitor, Monroe County,
West Virginia. Loope, California, formerly Monitor. Monitor (comics), a DC comics character. Monitors (comics), a group of fictional comic
book characters, who appear in books published by DC Comics.

